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  3  Working with Text 

KEY TERMS
•  bulleted list 

•  fonts 

•  Format Painter 

•  formatting 

•  line spacing 

•  Live Preview 

•  numbered list 

•  Quick Style 

•  text boxes 

•  texture 

•  WordArt 

LESSON SKILL MATRIX

Skill Exam Objective Objective Number

Formatting Characters Apply formatting and styles to text. 3.1.4

Formatting Paragraphs and Lists Create bulleted and numbered lists. 3.1.5

Inserting and Formatting WordArt Change text to WordArt. 3.1.1

Creating and Formatting Text Boxes Modify shape backgrounds.

Create multiple columns in 

a single shape.

2.2.1

3.1.2

Using Proofi ng Tools Proof presentations. 5.3.2
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 Fourth Coffee is a “boutique” company devoted to producing and distrib-

uting fi ne coffees and teas. As the sales manager for Fourth Coffee, you 

often produce and deliver presentations to your staff and managers on 

 topics such as realizing the full profi t potential of your delivery systems. 

Whenever you create a presentation, consider how the information  appears 

to your viewers. If the text in your slides is diffi cult to read, is  haphazardly 

formatted, if you cram too much text into your slides, or you have too much 

white space, your presentations will not be professional looking. In this 

lesson, you learn some basics of text formatting, including formatting char-

acters and paragraphs, creating and formatting lists, using WordArt to 

“jazz up” your text, and creating and modifying text boxes. 

 SOFTWARE ORIENTATION 

 Microsoft PowerPoint Basic Text Formatting Tools 

 Most of the PowerPoint basic text formatting tools are found on the Home tab of the Ribbon 
(see Figure 3-1). These are the tools you will use most often when working with text. 

 There are two groups of text formatting tools on the Ribbon: the Font group and the 
 Paragraph group. They allow you to fi ne-tune the text on your slides, right down to an indi-
vidual  character. These groups also provide access to the Font and Paragraph dialog boxes, 
which give you even more control over your text’s appearance. 

Figure 3-1

Basic text formatting tools (Font group and Paragraph group)
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   FORMATTING CHARACTERS 

 The term,  formatting , refers to the appearance of text or objects on a slide. Most of PowerPoint’s 
tools are devoted to formatting the various parts of your slides. All PowerPoint presentations 
are formatted with specifi c fonts, font sizes, and font attributes such as style and color. You can 
change the way characters look on a slide by using commands in the Font group on the Home tab 
or the Mini toolbar. The Format Painter can save you time by allowing you to copy formats from 
selected text to other text items. 

     Choosing Fonts and Font Sizes 

  Fonts  (sometimes called typefaces) are sets of characters, numbers, and symbols in a specifi c style 
or design. You can change the font and font size at any time on your slides. The following exercise 
shows you how to do this both with the Mini toolbar and with the Ribbon. 

STEP BY STEP  Choose Fonts and Font Sizes 

  GET READY  .  Before you begin these steps, make sure that your computer is on. Log on, 

if necessary. 

1.    Start PowerPoint, if the program is not already running. 

2.  Locate and open  Sales Pipeline  and save it as  Sales Pipeline Formats . 

3.    Go to  slide 2 . In the fi rst row of the table, double-click  Timing . The Mini toolbar appears 

above the selected text (see Figure 3-2). 

The Bottom Line

How do you apply formatting 
and styles to text?

3.1.4

4.  Click the  Font   drop-down arrow    on the Mini toolbar. A list of fonts appears. 

5.    Click  Berlin Sans FB Demi . PowerPoint applies the chosen font to the selected text. 

6.  Click the  Font Size drop-down arrow    on the Mini toolbar. A list of font sizes appears 

(see Figure 3-3). 

Figure 3-2

The Mini toolbar Font
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7.  Click  32 . PowerPoint applies the chosen font size to the selected text.  

8.  Double-click  Probability  in the top right cell of the table. 

9.      On the Home tab of the Ribbon, click the  Font drop-down arrow . A list of fonts appears 

(see Figure 3-4). 

Figure 3-3

Choosing a new font size 
from the Mini toolbar

Font Size

Figure 3-4

Choosing a new font 
from the Ribbon
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10.    Select the  Berlin Sans FB Demi  font. It is in the Recently Used Fonts section near the 

top of the list. 

11.    On the Home tab of the Ribbon, click the  Font Size drop-down arrow . A list of font sizes 

appears.  

12.  Click  32 .  

13.    Click  away from the selected text  to deselect it. Your slide should look like the one 

shown in Figure 3-5. 

14.     SAVE  the presentation. 

  PAUSE.   LEAVE  the presentation open to use in the next exercise. 

 To maintain formatting consistency between slides in a presentation, you might prefer to change 
the font and font size on the Slide Master, which fl ows down the change to all slides  automatically. 
Lesson 4 covers Slide Masters. 

 By default, PowerPoint presentations have two fonts: one font for the headings and one for the 
body text. (The same font can be used for both.) These font choices are a result of the theme. 
A theme is a set of formatting specifi cations, including the colors, fonts, graphic effects, and slide 
layouts available. All presentations have a theme, even blank ones. 

 To return to the default fonts provided by the theme, select a font from the Theme Fonts section 
of the Font drop-down list (see Figure 3-4). If you choose anything other than a theme font, as in 
the preceding exercise, applying a different theme will have no effect on that text, because manu-
ally applied fonts take precedence over theme fonts. 

 Using AutoFit to Change Text Size 

 By default, text in the placeholder boxes on a slide layout are set to AutoFit, so that if you type 
more text into them than will fi t, the text automatically gets smaller so that it will fi t into the 
placeholder box. If you then delete some of the text so that there is more room available, the text 
once again enlarges, up to its default size. You can change the AutoFit setting for a text box or 
placeholder as needed. 

Take Note

Figure 3-5

The new font and font size 
applied to the table headings
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STEP BY STEP Change AutoFit Behavior 

USE  the  Sales Pipeline Formats presentation that is still open from the preceding exercise. 

1.  On slide 3, type the following additional bullet points at the bottom of the slide: 

• Helps Engineering staff do long-range planning for future product enhancements

• Provides Marketing staff with critical data about customer needs and preferences

As you begin to type the second bullet point, AutoFit engages, and makes the text in 

the text box smaller so that it will all continue to fi t. 

2.    Click the  AutoFit  icon in the lower-left corner of the text box. A menu appears

(see Figure 3-6). 

Figure 3-6

Set AutoFit behavior

3.  Click  Stop Fitting Text to This Placeholder . The text returns to its default size and 

overfl ows the bottom of the text box. 

 Notice the other choices in Figure 3-6. You can choose to split text between two slides, continue 
on a new slide, or change to a two-column layout.  

4.    Click the  AutoFit  icon again, and click  AutoFit Text to Placeholder . 

5.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 AutoFit is enabled by default because it is a useful feature that most users appreciate in most situ-
ations. Rather than fi nding the maximum font size by trial and error that will allow the text to fi t 
in the allotted space, you can rely on AutoFit to fi gure that out for you. There are some situations, 
though, where AutoFit may not be appropriate. For example, you might want the slide titles to 
always appear in the same size font.  

 Take Note 
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 In manually created text boxes (covered later in this lesson), AutoFit is not enabled by default; 
instead, the text box itself resizes as needed to hold the text.  

 Applying Font Styles and Effects 

 Text on a PowerPoint slide can be boldfaced or italicized (called  font styles ), underlined, or format-
ted with other attributes such as strikethrough or shadow (called  effects  ) . In the following exercise, 
you will apply a font style and an effect to text on a slide, as well as adjust character spacing. 

 STEP BY STEP Apply Font Styles and Effects 

  USE  the  Sales Pipeline Formats    presentation that is still open from the previous exercise. 

1.     On slide 2, double-click  Timing  in the top left cell of the table. The Mini toolbar appears 

above the selected text.  

2.    Click the  Italic  button on the Mini toolbar (see Figure 3-7). PowerPoint formats the 

selected text in italic. 

 Take Note 

3.  Double-click  Probability  in the top right cell of the table, and then italicize it using any 

method. 

4.  Double-click  Timing  in the top left cell of the table, and then click the  dialog box 

launcher  in the Font group on the Ribbon (see Figure 3-8) to produce the Font

dialog box. 

Another Way
To apply italic 

formatting to a selection, you 
can also press Ctrl1I or click 
the Italic button in the Font 
group of the Ribbon. You can 
also right-click the selection 
and choose Font. 

Figure 3-7

Italicize selected text from the 
Mini toolbar
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5.      In the Font dialog box, on the Font tab, click to mark the  Small Caps  check box. 

6.      Click the  Character Spacing  tab. 

7.     Click the  Spacing   drop-down arrow , then click  Expanded  in the list (see Figure 3-9).  

Figure 3-8

Click the dialog box launcher 
in the Font group

Dialog box

launcher

Figure 3-9

Character Spacing tab of the 
Font dialog box

  8.     Click  OK . PowerPoint places 1 point of spacing between the letters and applies the 

Small Caps effect. 

9.     Double-click  Probability  in the top right cell of the table. 

10.     On the Quick Access Toolbar, click the  Repeat  button. PowerPoint repeats the last 

command you issued, applying the new character spacing to the selected text. Click 

away from the text to deselect it. Your slide should look like the one shown in 

Figure 3-10. 
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11.      SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 WordArt styles can also be used to format text and apply effects. They are covered later in this 
lesson. 

 Use font styles and effects to emphasize text on a slide. Besides the standard font styles—bold, 
italic, and underline—PowerPoint provides a variety of special effects such as strikethrough and 
small caps. You can also adjust character spacing and case to give your text a special look. To access 
more font effects, click the Font group’s dialog box launcher to open the Font dialog box. 

 Changing Font Color 

 An easy way to change text appearance is to modify its color. Use the Font Color button in the 
Font group on the Ribbon to access a palette of colors you can apply to selected text. 

 STEP BY STEP Change Font Color 

  USE  the  Sales Pipeline Formats    presentation that is still open from the previous exercise. 

1.  On slide 2, double-click  Timing  in the top left cell of the table. The Mini toolbar appears 

above the selected text. 

2.  Click the  Font Color   drop-down arrow  on the Mini toolbar. A palette of colors appears 

(see Figure 3-11). 

Cross 
Ref

Figure 3-10

Completed text formatting
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Figure 3-11

Choosing a different font color 
from the Mini toolbar

3.    In the fi rst row of theme colors, click  Orange  , Accent 6 . PowerPoint applies the color to 

the selected text. 

 When you hover the mouse pointer over a color box, the color’s name appears in a ScreenTip. 

4.  Double-click  Probability  in the top right cell of the table. 

5.  On the Home tab on the Ribbon, click the  Font Color drop-down arrow  and apply the 

color  Orange  , Accent 6  to the selected text. Your slide should resemble Figure 3-12 

when you are fi nished. 

 Take Note 

Figure 3-12

Color has been applied to the 
table headings

6.    SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 PowerPoint provides an almost limitless selection of colors that can be applied to fonts. You can 
select any color for your text, but it is usually best to use one of the colors provided by the presen-
tation’s theme, as you did in the preceding exercise. Each PowerPoint theme includes a set of 
 coordinating colors, which appear in the color palette when you click the Font Color button.
By selecting one of the theme’s colors, you can be sure that all the font colors in your slides will 
look well together on the screen making them easier to read. 



Lesson 392

 If you want to use a color that is not included in the theme, select one of the Standard Colors 
at the bottom of the color palette (see Figure 3-11), or click More Colors to open the Colors 
dialog box. In the Colors dialog box, you can choose from dozens of standard colors or create a 
custom color.  

 The difference between a theme color and a standard color is apparent when you switch to a dif-
ferent theme or color scheme as you will learn to do in Lesson 4.  A theme color will change to 
match the new colors for the presentation, but a standard color will remain fi xed. 

 Copying Character Formats with the Format Painter 

 As you format text in your presentations, you will want to keep similar types of text formatted the 
same way.  Format Painter  is a tool that copies formatting from one block of text to another. In 
this exercise, you will use Format Painter to copy some formatting. 

 STEP BY STEP Copy Character Formats with the Format Painter 

  USE  the  Sales Pipeline Formats    presentation that is still open from the previous exercise. 

1.  On slide 2, select the text in the title placeholder. 

2.  Change the font color to  Blue  ,   Accent 1  ,   Darker 25% . 

 To locate the color requested in step 2, point to the Blue Accent 1 color in the palette (fi fth from 
the left) and then slide the mouse down over the various tints and shades of that color until you 
fi nd the one for which the ScreenTip shows  Darker 25%.  

3.  Click the  Bold  button in the Ribbon’s Font group to apply the bold font style. 

4.  Click the  Text Shadow  button in the Font group to apply the shadow font style

(see Figure 3-13). 

 Take Note 

Figure 3-13

Format the title text

Format Painter

Bold

Text Shadow
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5.    With the text still selected, click the  Format Painter  button in the Clipboard group. 

6.  Go to slide 3, and then click the word  Assessment . The formatting is painted onto 

that word. 

7.  Click the  Format Painter  button again to copy the formatting that is now applied to 

Assessment. 

8.  Drag across the word  Critical , releasing the mouse button when the word is selected. 

The formatting is painted onto that word. 

9.    Double-click the  Format Painter  button. Double-clicking it makes the feature stay on 

until you turn it off. 

10.    Go to each of the remaining slides in the presentation, and drag across all the 

text in the title of each slide. The Format Painter applies the new formatting 

to the text. 

 If you accidentally click anywhere that does not contain editable text, the Format Painter feature 
turns off. If that happens, select some of the already formatted text, and then click the Format 
Painter button to turn the feature back on. 

11.     When you are fi nished painting each slide title, press  Esc  or click the  Format Painter  

button again to turn the feature off. 

12.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Format Painter makes it easy to apply the same formatting to multiple blocks of text no matter 
where they are in the presentation. If you want to copy a format only once, simply click the button. 
To copy a format multiple times, double-click the button, and the feature will stay on until you 
turn it off. Not only does this tool reduce your workload, but it also ensures consistency through-
out a presentation. (Another way to achieve consistency is to make changes to the Slide Master 
rather than to individual slides; you will learn about that in Lesson 4.) 

 The Format Painter feature can copy not only character formats but paragraph formats such as 
alignments and line spacing. You will learn about paragraph formats in the next section. 

 FORMATTING PARAGRAPHS AND LISTS 

 You can change the look of paragraph text by modifying alignment or line spacing. When you 
apply formatting to a paragraph, all the text within that paragraph receives the same formatting. 
Lists make the information on slides easy to read and remember. PowerPoint provides for several 
levels of bulleted lists that you can modify for special effects. You can also create numbered lists 
when your slide text implies a specifi c order. 

 Aligning Paragraphs 

 By default, PowerPoint aligns text along the left margin. In this exercise, you will change the 
alignment of items in a bulleted list to customize a slide’s appearance. 

 STEP BY STEP Align Paragraphs 

  USE  the  Sales Pipeline Formats    presentation that is still open from the previous exercise. 

1.  On slide 4, click in the  second bulleted item  ( Sales Districts ). 

2.   On the Home tab, click the  Center  button in the Ribbon’s Paragraph group. PowerPoint 

aligns the paragraph in the center of the text placeholder. 

3.    Click in the  third bulleted item  ( Sales Reps ). 

 Take Note 

The Bottom Line



Lesson 394

4.    Click the  Align Right  button in the Paragraph group. PowerPoint aligns the paragraph 

to the right side of the text placeholder. Your slide should look like the one shown in 

Figure 3-14. 

Figure 3-14

Aligning paragraphs to the 
left, center, and right

Center Align RightAlign Left

5.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 When you apply paragraph formats such as alignment, you do not have to select the entire para-
graph of text. Just click anywhere in the paragraph and apply the format. The formatting applies 
to the entire paragraph, even if the paragraph is several lines or sentences long. 

 When you begin a new paragraph by pressing Enter after an existing paragraph, the new para-
graph keeps the same alignment and formatting as the paragraph above it. For example, if you 
start a new paragraph after a paragraph aligned to the right, the new paragraph aligns to the right 
as well. 

 PowerPoint provides four paragraph alignment options: 

•   Align Text Left:   Aligns the paragraph at the left edge of the object in which the text resides 
whether the object containing the text is a placeholder, a table cell, or a text box.  

•   Center:   Aligns the paragraph in the center of the object.  

•   Align Text Right:   Aligns the paragraph at the right edge of the object.  

•   Justify:   Aligns text to both the left and right margins to distribute the paragraph of text evenly 
across the width of the object, if   possible. PowerPoint justifi es text by adding spaces between 
words and characters. The fi nal line of a justifi ed paragraph is left-aligned, so if the paragraph 
occupies only one line, it will appear left-aligned.  

Another Way
The paragraph 

alignment tools also appear on 
the Mini toolbar when you 
right-click within a paragraph.

Another Way
To left-align text, 

press Ctrl1L. To center text, 
press Ctrl1E. To right-align 
text, press Ctrl1R. You can also 
right-click and choose 
Paragraph and set alignment in 
the Paragraph dialog box.
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 Setting Line Spacing 

 In this exercise, you learn how to adjust  line spacing  to allow more or less room between lines of 
a paragraph and also between paragraphs. Line spacing changes can help you display text more 
attractively or fi t more text on a slide. By default, PowerPoint formats your paragraphs so that 
one line of blank space lies between each paragraph and between the lines within a paragraph. Use 
the Line Spacing button to adjust the spacing to 1.0, 1.5, 2.0, 2.5, or 3.0. You also can use the Line 
Spacing Options command to display the Paragraph dialog box. With this dialog box, you can 
fi ne-tune the spacing between each paragraph. 

 STEP BY STEP Set Paragraph Line Spacing 

  USE  the  Sales Pipeline Format  s    presentation that is still open from the previous exercise. 

1.  On slide 3, select the  last two bulleted paragraphs  ,  and then press  Delete . You are 

doing this so that AutoFit no longer resizes the text to make it all fi t, and so there is 

enough room in the text box to clearly see the results of the line spacing change you 

are going to be making.  

2.   Select all the remaining bulleted paragraphs on the slide. One way to do this is to click 

inside the text placeholder that contains the bullets and press  Ctrl   1   A . You can also 

drag across the bullets to select them. 

3.  Click the  Line Spacing  button in the Paragraph group. A list of line spacing options 

appears (see Figure 3-15). 

Figure 3-15

Set an amount of spacing 
between lines

Line Spacing

4.      Select  1.5  .  PowerPoint formats the paragraphs so each line is separated by 1.5 lines of 

blank space. 

5.    Click the  Line Spacing  button again, and then click  Line Spacing Options  at the bottom 

of the menu. The Paragraph dialog box opens. 

Another Way
You can also open 

the Paragraph dialog box by 
clicking the dialog box launcher 
in the Paragraph group.



Lesson 396

10.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

6.  In the Spacing section of the dialog box, set the following values: 

 Before:  0 pt  

 After:  9 pt  

7.    Open the Line Spacing drop-down list, and then click  Exactly . Then in the text box to its 

right, type  38 . The dialog box settings should look like Figure 3-16. 

Figure 3-16

In the Paragraph dialog box, 
you can set spacing both 

between lines within a 
paragraph and before/after 

each paragraph

8.    Click  OK . The settings are applied to all the bullets on the slide. 

9.    Click  away from the bullets  to deselect them. The slide should resemble Figure 3-17. 

Figure 3-17

The slide with line spacing 
applied
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 The Line Spacing drop-down list in the Paragraph dialog box enables you to select from these 
settings: 

•   Single:     Sets the spacing to what single spacing would be for the font size in use. The actual 
amount changes depending on the largest font size used in that paragraph.  

•   1.5 lines:     Sets the spacing halfway between single spacing and double spacing.  

•   Double:     Sets the spacing to what double spacing would be for the font size in use.  

•   Exactly:     Sets the spacing to a precise number of points. If you change the font size(s) in use, this 
value does not change automatically.  

•   Multiple:     Enables you to specify a multiplier for spacing. For example, you might enter 1.25 for 
spacing halfway between single-spacing and 1.5   lines   spacing.  

 Setting Indentation 

 Indentation controls the horizontal spacing of a paragraph, much as line spacing controls its verti-
cal spacing. Indentation determines how far from the text box’s left and right margins the text 
appears. In this exercise you will set the indentation for some paragraphs. 

 STEP BY STEP Set Indentation 

  USE  the  Sales Pipeline Format  s    presentation that is still open from the previous exercise. 

1.  On slide 3, click in the  fi rst bulleted paragraph .  

2.  Click the  dialog box launcher  for the Paragraph group. The Paragraph dialog box 

opens. 

3.    In the Indentation section of the dialog box, set the  Before text  value to  0.7"  

(see Figure 3-18). 

Another Way
Instead of clicking 

the dialog box launcher, you 
can right-click and choose 
Paragraph.

Figure 3-18

Change the indentation in the 
Paragraph dialog box

 The Before Text setting refers to the paragraph as a whole. A hanging indent is a reverse indent 
and applies only to the fi rst line.  

4.    Click  OK . The new setting is applied. Both lines of the fi rst bullet are indented more 

than the other bullets (see Figure 3-19). The placement of the bullet in relation to the 

rest of the text has not changed. 

 Take Note 
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5.  Select the other two bulleted paragraphs and repeat steps 3-4. 

6.  Select all three bulleted paragraphs. 

7.    Click the  dialog box launcher  for the Paragraph group. The Paragraph dialog box 

opens. 

8.  Set the Hanging indent to  0.6"  ,  and then click  OK  to apply the new setting. 

 The bullet character has moved to the left in relation to the paragraph; the paragraph text has
not moved.  

9.       SAVE  the  Sales Pipeline Formats    presentation, and then close it. 

  PAUSE .  LEAVE  PowerPoint open to use in the next exercise. 

 By promoting and demoting bulleted paragraphs in the outline level, as you learned to do in 
 Lesson 2, you can indirectly control their indentation. However, you can also directly change 
paragraphs’ indentations via the Paragraph dialog box without altering their outline levels. This is 
useful when you want to change how a paragraph is formatted without changing its meaning or 
importance in the presentation’s message. 

 There are two indentation settings. The fi rst one, Before Text, applies to all lines in the paragraph. 
The second one, Special, is a specialty setting that varies according to the paragraph type: 

•   Hanging:   A reverse indent. The fi rst line (which usually contains a bullet character when Hang-
ing is used) is reverse-indented by the specifi ed amount. In other words, the fi rst line has a lesser 
indent than the other lines, so it hangs off into the left margin. In the preceding steps, the hang-
ing indent was 0.6".  

•   First line:   A standard fi rst-line indent. The fi rst line is indented an extra amount on top of what 
is specifi ed for the Before Text indentation setting.   

•   (none):   This setting removes any special indents for the fi rst line.  

 Indents can be set for any paragraph, but are often the most useful for bulleted and numbered lists. 
You will learn more about creating and formatting lists in the next section. 

 Take Note 

Figure 3-19

The result of a change to the 
Before Text indentation setting 

for the fi rst paragraph
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 Creating Numbered Lists 

 PowerPoint enables you to create  numbered lists  to place a list of itemized information in numer-
ic order. Numbered lists are used for procedural steps, action items, and other information where 
the order in which the items appear is signifi cant. In the following exercise, you will create a num-
bered list from a list of items on a slide. 

 STEP BY STEP Create Numbered Lists 

  GET READY . To create a numbered list, perform the following steps: 

1.       OPEN  the  Leveraging Corporate Cash  presentation, and then save it as  Leveraging 

Corporate Cash Lists . 

2.    On slide 2, click in the fi rst line of the text in the  text placeholder  ( Determine inventory 

turnover ). 

3.  Click the  Numbering  button in the Paragraph group. PowerPoint formats the sentence 

with a number 1. 

4.  Select the last three lines in the text placeholder. 

5.    Click the  Numbering  button. PowerPoint applies numbers 2 through 4. 

6.    Click outside the text placeholder to clear any text selection. Your slide should look like 

the one shown in Figure 3-20. 

How can you create 
numbered lists in 

PowerPoint? 

3.1.5

7.    Click in the text placeholder containing the numbered list, and then press  Ctrl   1   A  to 

select the entire list. 

8.    Click the  down arrow  to the right of the Numbering button, opening a gallery of 

numbering styles. 

9.      Click the uppercase Roman numeral style as in Figure 3-21. 

NumberingFigure 3-20

A numbered list

Another Way
To number a 

paragraph, right-click the 
paragraph, and then click 
Numbering on the shortcut 
menu.

Another Way
You can also drag 

across the list to select it.
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10.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 When you fi nish typing text in a numbered paragraph, you can press Enter to start a new  numbered 
paragraph that continues the same numbering sequence.  PowerPoint automatically numbers the 
new paragraph with the next number in the sequence of numbers so you can continue the list 
uninterrupted. To turn off numbering, press Enter twice or click the Numbering button on
the Home tab. 

 By default, PowerPoint numbers items using numerals followed by periods. You can, however, 
change the numbering format to numerals followed by parentheses, upper or lowercase Roman 
numerals, or upper or lowercase letters. To change the numbering format, click the Numbering 
button’s drop-down arrow and select a new format from the gallery.  

 For even more control over the numbering format, click Bullets and Numbering on the gallery to 
display the Bullets and Numbering dialog box. You can use this dialog box to choose what number 
to start the list with, change the size of the numbers, or change their color. You will work with that 
dialog box in the next exercise. 

 Working with Bulleted Lists 

 Bullets are small dots, arrows, circles, diamonds, or other graphics that appear before a short 
phrase or word. A  bulleted list  is a set of paragraphs (two or more) that each start with a bullet 
symbol. Bulleted lists   are the most popular way to present items on PowerPoint presentations. In 
fact, most of PowerPoint’s text placeholders automatically format text as a bulleted list. In the 
following exercise you will change the formats of a bulleted list. 

Figure 3-21

Changing the numbered list’s 
numbering style



Working with Text 101

STEP BY STEP Work with Bulleted Lists 

USE the  Leveraging Corporate Cash Lists presentation that is still open from the previous 

exercise. 

1.    On slide 3, select  all of the bulleted list items  in the text box. To do this, you can either 

drag across them or press  Ctrl   1   A . 

2.  Click the  drop-down arrow  to the right of the Bullets button in the Paragraph group. 

PowerPoint displays a gallery of bullet styles. 

 If a series of paragraphs does not have bullets, you can add them by selecting the paragraphs and 
then clicking the Bullets button in the Paragraph group. 

3.  Click  Check mark Bullets (see Figure 3-22). PowerPoint applies the bullet style to the 

selected paragraphs. 

How can you create bulleted 
lists in PowerPoint?

3.1.5

Take Note

BulletsFigure 3-22

Select a different bullet 
character

 If you hover the mouse over a certain bullet style on the list, the selected text on the slide is pre-
viewed using that bullet character. This is an example of the  Live Preview  feature, which also 
works with various other types of formatting too, including borders and fi lls.  

4.  With the text still selected, click the  Bullets   drop-down arrow  again, and then 

click  Bullets and Numbering . The Bullets and Numbering dialog box appears 

(see Figure 3-23). 

Take Note
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5.    In the Size: box, type  80 . This reduces the bullets’ size to 80% of the text’s size. 

6.    Click the  Color   drop-down arrow , and then click  Blue, Accent 1 . (It is the fi fth color 

from the left on the fi rst line.) This changes the color of the bullets. 

7.    Click  OK . PowerPoint applies the changes.  

8.     SAVE  the  Leveraging Corporate Cash Lists  presentation, and then close it. 

  PAUSE .  LEAVE  PowerPoint open to use in the next exercise. 

 Each PowerPoint theme supplies bullet characters for up to nine levels of bullets, and these char-
acters differ according to theme. When you create a bulleted list on your slide, you can continue 
it automatically after the last item by pressing Enter. PowerPoint automatically adds the new para-
graph with a bullet. 

 INSERTING AND FORMATTING WORDART 

 The  WordArt  feature allows you to use text to create a graphic object. PowerPoint’s WordArt 
feature can change standard text into fl ashy, eye-catching graphics. Use WordArt’s formatting 
options to change the WordArt fi ll or outline color or apply special effects. You can also apply 
WordArt styles to any slide text to give it special emphasis. 

 Inserting a WordArt Graphic 

 In this exercise, you will enhance the appearance of slide titles by converting them to 
WordArt. 

 STEP BY STEP Insert a WordArt Graphic 

  GET READY . To insert a WordArt graphic, perform the following steps: 

1.     OPEN  the  Full Profi t Potential  presentation, and save it as  Full Profi t . Notice that the 

fi rst slide has a subtitle but no title placeholder. 

2.      Click the  Insert  tab on the Ribbon, and click the  WordArt  button to display a gallery 

of WordArt styles (see Figure 3-24). 

The Bottom Line

How can you change regular 
text to WordArt? 

3.1.1

Figure 3-23

The Bullets and Numbering 
dialog box
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3.      Click the  Gradient Fill –   Gold,   Accent 1  , Refl ection  WordArt style. PowerPoint displays 

the WordArt graphic with the sample text  Your   t  ext   h  ere . 

4.    Type  Full Profi t  to replace the sample text. Your slide should resemble Figure 3-25. 

5.       SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

Figure 3-24

Gallery of WordArt styles

Figure 3-25

A new WordArt graphic 
on a slide
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   After you have inserted the WordArt graphic, you can format it in a number of ways. You can 
change the style from the WordArt gallery, you can modify the fi ll or the outline, or you can apply 
a number of interesting special effects. You can also modify the text of the graphic at any time. 
Click the graphic to open the placeholder just as when editing a slide’s title or body text, and then 
edit the text as desired. 

   Formatting a WordArt Graphic 

 To format a WordArt graphic, you use the tools on one of PowerPoint’s contextual tabs, the 
 Drawing Tools Format tab. In the next several exercises, you will use these tools to modify the 
WordArt’s fi ll and outline and apply an effect. 

 Changing the WordArt Fill Color 

 The WordArt fi ll color is the color you see inside the WordArt characters. You can change the fi ll 
color by using the color palette for the current theme or any other available color. You can also 
apply a special effect fi ll to WordArt such as a texture, gradient, or pattern.  

 STEP BY STEP Apply a Solid Fill Color to WordArt 

  USE  the  Full Profi t  presentation that is still open from the previous exercise. 

1.    Select the WordArt graphic’s text on slide 1. Make sure you select the text itself and not 

just the outer frame of the WordArt object. Note that the Drawing Tools Format tab 

becomes active on the Ribbon. 

2.    Click the  Drawing Tools Format  tab, and then locate the WordArt Styles group. 

3.  Click the  Text Fill drop-down arrow . PowerPoint displays the Theme Colors palette. 

4.    Click the  Gray-25%, Text 2  theme color as the fi ll color (see Figure 3-26). It’s the fourth 

color in the top row. PowerPoint changes the fi ll of the text. 

Figure 3-26

Filling a WordArt object with a 
solid color

5.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 
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 One way to fi ne-tune the graphic you have inserted is to change the fi ll color of the WordArt 
 object. You can use any of the colors on the Theme Colors palette to make sure the object 
 coordinates with other items in the presentation. 

 You can also choose from the Standard Colors palette or select another color from the Colors 
 dialog box. To access these colors, click More Fill Colors on the palette (see Figure 3-26) to open 
the Colors dialog box. You can “mix” your own colors on the Custom tab or click the Standard 
tab to choose from a palette of premixed colors. 

 Applying a Texture Fill to WordArt 

  Textures  are graphics that repeat to fi ll an object with a surface that resembles a familiar material 
such as straw, marble, paper, or wood. The texture graphics are specially designed so that the left 
edge blends in with the right edge (and the top edge with the bottom edge), so that when you place 
copies side by side, it looks like one seamless surface. In this exercise, you will practice applying a 
texture fi ll to WordArt. 

 STEP BY STEP Apply a Texture Fill to WordArt 

  USE  the  Full Profi t  presentation that is still open from the previous exercise. 

1.    Select the WordArt graphic’s text on slide 1 if it is not already selected. 

2.  On the Drawing Tools Format tab, click the  Text Fill drop-down arrow . PowerPoint 

displays the Theme Colors palette. 

3.    Point to Texture, and then click the  Granite  texture (see Figure 3-27).  PowerPoint 

changes the fi ll of the graphic. 

Figure 3-27

Filling a WordArt object 
with a texture

Granite
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4.  Press Ctrl 1 B to make the WordArt bold so you can see the texture applied to it more 

clearly. 

5.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

   Changing the WordArt Outline Color 

 Most WordArt styles include a colored outline around the edges of the WordArt characters. Just 
as with a WordArt object’s fi ll color, you can fi ne-tune the outline color of the object. You have the 
same color options as for changing a fi ll color. The Text Outline Theme Colors palette also allows 
you to remove the outline, change its weight, or apply a dash style to the outline. In this exercise 
you will learn how to change the outline color to fi ne-tune a WordArt graphic. 

 STEP BY STEP Change the WordArt Outline Color 

  USE  the  Full Profi t  presentation that is still open from the previous exercise. 

1.    Select the  WordArt graphic’s text  on slide 1 if it is not already selected. 

2.    On the Drawing Tools Format tab, click the  Text Outline drop-down arrow . PowerPoint 

displays the Theme Colors palette (see Figure 3-28). 

Text Outline

Figure 3-28

Changing the border color of a 
WordArt object

3.    Click  More Outline Colors  .    The Colors dialog box opens. 

4.  On the Standard tab, click a  dark blue   hexagon  (see Figure 3-29). 
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5.  Click  OK . The dark blue background blends in with the background of the slide, so it is 

not obvious to see.  

6.    Zoom in on the object to  200%  to see it more clearly. Zoom out to  100%  when you are 

fi nished looking at the border. 

7.  Select the WordArt again if necessary, click the  Text Outline   drop-down arrow  

again, point to  Weight , and click  3 pt . The outline becomes more dramatic and easier 

to see. 

8.    Click the    Text Outline     drop-down arrow  again, and click  No Outline .   The outline 

disappears. 

9.  Click the Fit Slide to Current Window icon in the lower right corner of the PowerPoint 

window to view the entire slide again. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Applying Special Effects to WordArt 

 You can apply special effects to your WordArt objects such as shadows, refl ections, glows, trans-
formations, and more. These effects can also be applied to the other object types that you will 
learn about in later lessons such as drawn lines and shapes.  

 STEP BY STEP Apply Special Effects to WordArt 

  USE  the  Full Profi t  presentation that is still open from the previous exercise. 

1.    Select the  WordArt graphic  on slide 1 if it is not already selected. 

2.    On the Drawing Tools Format tab, click the  Text Effects   drop-down arrow . PowerPoint 

displays the Text Effects menu. 

3.  Hover your mouse over  Refl ection . PowerPoint displays the Refl ection special effects 

(see Figure 3-30). This WordArt already has one type of refl ection applied but not the 

type we want. 

Figure 3-29

Choose a color from the Colors 
dialog box
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4.  Click  Tight Refl ection, touching  (the fi rst refl ection under the Refl ection Variations 

heading). PowerPoint changes the refl ection effect to the chosen one. 

5.  Click the WordArt graphic and drag it close to the subtitle (see Figure 3-31). 

Figure 3-30

A Refl ection special effect 
 added to the WordArt object

Figure 3-31

The WordArt text repositioned 
above the subtitle

6.       SAVE  the presentation. 

  PAUSE  .   LEAVE  the presentation open to use in the next exercise. 

 WordArt special effects provide a way to spice up an ordinary slide. Although you should not use 
WordArt special effects on all your slides, you may want to look for spots in your presentations 
where a little artistic punch will liven up your slide show. Always consider your audience and your 
topic when adding special effects. For example, a presentation discussing plant closings and layoffs 
would not be an appropriate place for a cheerful-looking WordArt graphic. 

 Formatting Text with WordArt Styles 

 You do not have to insert a WordArt graphic to use the WordArt styles. You can apply WordArt 
styles to any text in a slide. Applying WordArt styles to regular text in a presentation is an addi-
tional way to format the text to customize the presentation. You can use the same features you 
used to format the WordArt graphic to format a title or bulleted text: Text Fill, Text Outline, and 
Text Effects. In this exercise, you will practice applying WordArt styles to text. 
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5.    Click the  Pattern Fill - Purple, Accent 1, 50%, Hard Shadow - Accent 1  WordArt style 

(see Figure 3-33). The style is applied to the selected text. 

STEP BY STEP Format Text with WordArt Styles 

USE  the  Full Profi t presentation that is still open from the previous exercise. 

1.    Go to  slide 2 . 

2.  Select the slide title,  On-Time Delivery . 

3.    Zoom in to  100%  on the selected text, so you can see the effects more clearly that you 

will apply. 

4.  On the Drawing Tools Format tab, click the  More  button in the WordArt Styles group 

(see Figure 3-32) to display the WordArt Styles gallery. 

Figure 3-32

The More button opens the 
WordArt Styles gallery

Figure 3-33

Select a WordArt style

6.      On the Home tab, in the Font group, open the Font Size drop-down list and choose  60 . 

7.    Click outside the text placeholder to clear its border. The title should look like the one 

shown in Figure 3-34. 
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8.   SAVE  and close the  Full Profi t    presentation. 

  PAUSE .  LEAVE  PowerPoint open to use in the next exercise. 

 CREATING AND FORMATTING TEXT BOXES 

 Although PowerPoint layouts are very fl exible and provide a number of ways to insert text, you 
may occasionally need to insert text in a location for which there is no default placeholder. 
 Text boxes  are the answer in this circumstance. A text box is a free-fl oating box into which you 
can type text. You can use text boxes as containers for extra text that is not part of a placeholder. 
A text box can hold a few words, an entire paragraph of text, or even several paragraphs of text. 
Text boxes make it easy to position content anywhere on a slide.  

 Adding a Text Box to a Slide 

 Text boxes can be used to place text on a slide any place you want it. In this exercise, you will add 
a text box to a slide and then insert text into the text box. 

 STEP BY STEP Add a Text Box to a Slide 

1.     OPEN  the  Profi t Analysis  presentation and save it as  Profi t Analysis Boxes . 

2.  If the rulers do not appear, on the View tab click to mark the  Ruler  check box so that 

rulers appear around the slide. 

3.      Go to  slide 1 . 

4.    On the Insert tab, click  Text Box  in the Text group. The cursor changes to a text 

insertion pointer. 

5.    Move the pointer to the right side of the slide, below the red dot and at the 3" mark on 

the horizontal ruler.  

6.      Click and hold down the mouse button. Drag the mouse down and to the right to create 

a rectangle that is 3" wide. Use the horizontal ruler to gauge the size. 

 The height you draw the text box does not matter because the height automatically fi ts the  content. 
When blank, the text box is one line high. It expands as you type more lines. 

7.        Release the mouse button. The rectangle changes to a text box .  

 When you release the mouse button after creating a text box, the Ribbon automatically displays 
the Home tab. 

8.      Type  Fourth Coffee  in the text box. 

The Bottom Line

Take Note

Take Note

Figure 3-34

The title with WordArt applied
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11.       SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 You have two options when creating a text box. If you simply click the slide with the text box 
pointer, you create a text box in which text will not wrap. As you enter text, the text box expands 
horizontally to accommodate the text. If you want to create a text box that will contain the text in 
a specifi c area, with text wrapping from line to line, you draw a desired width with the text box 
pointer as you did in the preceding steps. When text reaches that border, it wraps to the next line. 

 You can change a text box’s wrap setting. Right-click its border, and then click Format Shape. 
From the Format Shape task pane, select Shape Options, choose the Size & Properties icon, and 
under the Text Box settings, mark or clear the Wrap Text in Shape check box. 

 Resizing a Text Box 

 Text boxes can be resized to make room for the addition of other text boxes or objects or to  rearrange 
a text box’s contents. In this exercise, you will practice resizing text boxes on a  PowerPoint slide. 

 STEP BY STEP Resize a Text Box 

  USE  the  Profi t Analysis Boxes  presentation that is still open from the previous exercise. 

1.      Display  slide 2 . 

2.      On the Insert tab, click  Text Box  in the Text group. 

Take Note

9.  Select the text  Fourth Coffee , and then change the Font Size to  28    using the Font 

drop-down list on the Home tab. 

10.      Click  outside the text box  to clear its border. Your slide should look like the one shown 

in Figure 3-35. 

Place text box here

Figure 3-35

Inserting a text box



Lesson 3112

Mouse pointer

Figure 3-37

Position the mouse pointer 
over the right-side handle on 

the text box frame

3.    Drag to  draw a text box  under the Divisional Breakdown title. Make the text box 

approximately  4"  wide. 

4.    Type the following items into the text box, pressing  Enter  after each item to start a new 

paragraph (see Figure 3-36). 

   Sales  

   Marketing  

   Purchasing  

   Production  

   Distribution  

   Customer Service  

   Human Resources  

   Product Development  

   Information Technology  

   Administration  

5.    Move the  mouse pointer  to the white square in the middle of the text box’s right 

border. This is a resizing handle   or selection handle. The pointer changes to a double-

headed arrow (see Figure 3-37). 

Figure 3-36

Type text into the text box

6.    Click and hold down the mouse button. 

 A text box has eight resizing handles: one in each corner and one in the middle of each side. Take Note
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7.  Hold and Drag the  sizing handle  to the left until the text box’s right border is close to 

the text (all entries should still be on a single line).  

8.  Release the  mouse button . The text box resizes to a smaller size. Your slide should look 

like the one in Figure 3-38. 

9.      Click outside the text box to clear its border. 

10.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

Formatting a Text Box 

 You can apply many different types of formatting to text boxes to make them more eye-catching 
and graphical. You can apply a Quick Style, add a border, or apply a solid, gradient, texture, or 
pattern fi ll to its background.  

Applying a Quick Style to a Text Box 

 PowerPoint’s  Quick Styles  allow you to quickly format any text box or placeholder with a combi-
nation of fi ll, border, and effect formats to make the object stand out on the slide. In this exercise, 
you apply a Quick Style to a text box, but PowerPoint also provides Quick Styles for other features 
such as tables, SmartArt graphics, charts, and pictures. 

STEP BY STEP Apply a Quick Style to a Text Box 

USE  the  Profi t Analysis Boxes  presentation that is still open from the previous exercise. 

1.  Go to  slide 1 . 

2.    Click the  Fourth Coffee text box  to select it. 

3.      On the Home tab, click the  Quick Styles  button to display a gallery of Quick Styles. 

4.  Select the  Intense Effect –   Gray-50%,   Accent   5  Quick Style, the next-to-last thumbnail 

in the last row (see Figure 3-39). The Quick Style formatting is applied to the text box. 

Figure 3-38

The resized text box

Right edge of text box

is now closer to the text
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Figure 3-39

A Quick Style applied to 
a text box

5.       SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 There are several advantages to using Quick Styles to format an object. Each Quick Style provides 
a number of formatting options that would take more time to apply separately. Quick Styles give 
a professional appearance to slides. Using Quick Styles can also make it easy to format  consistently 
throughout a presentation. 

 Applying Fill and Border Formatting to a Text Box 

   If you want more control over formatting applied to a text box, you can use the Shape Fill and 
Shape Outline tools to set the formatting for a text box on your own. In this exercise, you apply 
fi ll and border formatting to a text box. 

 STEP BY STEP Apply Fill and Border Formatting to a Text Box 

  USE  the  Profi t Analysis Boxes  presentation that is still open from the previous exercise. 

1.      Go to  slide 2 . 

2.      Click  inside the text box list . PowerPoint displays the text box border and sizing 

handles. 

3.  On the Drawing Tools Format tab, click the  Shape Fill   drop-down arrow  in the Shape 

Styles group. The Theme Colors palette for the text box fi ll color appears. 

4.    Click the  Tan  , Background 2, Darker 25%  theme color. PowerPoint formats the text box 

fi ll with this color (see Figure 3-40). 

How can you modify a text 
box’s background? 

2.2.1
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Figure 3-40

Select a shape fi ll

5.    Click the  Shape Outline drop-down arrow . The Theme Colors palette for the text box 

border color appears. 

6.    Click the  Orange, Accent 1, Darker 25%  theme color. PowerPoint formats the text box 

border with this color.  

7.    Click the  Shape Outline drop-down arrow  again. 

8.      Click or hover the mouse pointer over  Weight . A menu with line weights appears. 

9.    Click  3 pt . PowerPoint resizes the text box border to a 3-point border size 

(see Figure 3-41). 
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 You can change the style of a text box’s outline from solid to dashed or dotted by selecting the 
Dashes option from the Shape Outline drop-down menu.  

10.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Applying Special Fills to a Text Box 

 You are not limited to plain solid colors for text box fi lls. You can fi ll using gradients, patterns, 
textures, and pictures to create interesting special effects. In this exercise, you will insert a picture 
and apply a gradient color to a text box. 

 STEP BY STEP Apply Picture and Gradient Fills to a Text Box 

  USE  the  Profi t Analysis Boxes  presentation that is still open from the previous exercise. 

1.    On slide 2, select the  text box containing the list of divisions . 

2.    On the Drawing Tools Format tab, click the  Shape Fill  button. A menu opens. 

3.    In the menu, click  Picture . The Insert Picture dialog box opens. 

4.    Click the Browse button that is next to “From a fi le.” Then navigate to the location of 

the data fi les for this lesson and click  golden  .jpg . 

5.  Click  Insert . The Insert Picture dialog box closes and the picture is inserted as a 

background in the text box (see Figure 3-42). 

Take Note

Figure 3-41

A 3-pt shape outline 
has been applied
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Figure 3-42

A picture applied as a text box 
background

6.    With the same text box still selected, on the Drawing Tools Format tab, click 

the  Shape Fill  button. A menu appears. 

7.    Click or hover the mouse over  Gradient . A menu of gradient presets appears.  

8.    Click the  Linear Right  sample in the Light Variations section (see Figure 3-43).

To determine the name of a sample, hover the mouse pointer over each sample, so a 

ScreenTip appears with its name. 

Figure 3-43

Select a gradient preset

9. On the Drawing Tools Format tab, click  Shape Fill , point to  Gradient , and click  More 

Gradients . The Format Shape task pane opens. 

10.  Click the  Color  button in the task pane, and click  Dark Red ,  Accent 2 . 

11.      Drag the  center stop  on the Gradient Stops bar until the value in the Position box reads 

25 (see Figure 3-44).  
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12.  Click  Close  in the upper right corner of the task pane to close it. 

13.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Gradient fi lls can be much more complex than the simple ones you applied in the preceding exer-
cise. You can choose from several preset color combinations in the Format Shape task pane (see 
Figure 3-44), or create your own color combinations. The slider in the task pane can be adjusted 
to create multipoint gradient effects in which you choose exactly which colors appear and in what 
proportions. You can also adjust the brightness and transparency of the gradient at various points 
in the fi ll. 

 Applying Texture and Pattern Fills 

 Texture and pattern fi lls are alternatives to plain colored fi lls. As you learned earlier in the les-
son, a texture fi ll repeats a small graphic to fi ll the area; texture graphics are specially designed 
so that the edges blend together and it looks like a single graphic. Texture graphics usually 
simulate some type of textured material like wood, marble, or fabric. A pattern fi ll is a repeating 
pattern that consists of a background color and a foreground color like the pattern on a checked 
table cloth or a pinstripe suit. In the following exercise you will apply texture and pattern fi lls to 
a text box. 

Drag the center stop

Number indicates current

position of selected stop

Figure 3-44

Select a different color for the 
gradient
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STEP BY STEP Apply Texture and Pattern Fills to a Text Box 

USE  the  Profi t Analysis Boxes presentation that is still open from the previous exercise. 

1.  On slide 2, click the  Text Box  button on the Insert tab, and drag to  draw a new text box  

to the right of the existing one, approximately 4.5" in width. 

2.    In the new text box, type the following:  Each division makes a unique and valuable 

contribution to the organization.  

3.    Select the  new text box , and on the Drawing Tools Format tab, click  Shape Fill , and 

hover the  mouse pointer over Texture  in the menu that appears. 

4.    Click the  Papyrus  texture. To locate the correct texture, hover the  mouse pointer     over 

each texture  to display the ScreenTip (see Figure 3-45). The texture is applied to the 

text box.  

Papyrus texture

Figure 3-45

Apply a texture fi ll to a text 
box

5.    On slide 3, select the  text box containing the bulleted list . 

6.    Right-click the  text box’s border  to activate the shortcut menu and click  Format Shape . 

The Format Shape task pane opens. 

7.    Click  Pattern Fill . A selection of patterns appears. 

8.    Click the  Light downward diagonal  pattern (fi rst pattern in third row). 

9.    Click the  Foreground  button to browse for a color. 

10.    Click  Brown  ,   Accent 6  (see Figure 3-46). The new fi ll appears in the text box. 
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11.    Click  Close   (X)  to close the task pane.  

12.   SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

   Changing Text Box Shape and Applying Effects 

 You can apply the same special effects to text boxes as you can to WordArt, drawn shapes, and 
other objects. These special effects include refl ection, glow, 3-D effects, shadows, soft edges, and 
beveling. You can also modify the shape of a text box, using any of the dozens of preset shapes that 
PowerPoint offers. In this exercise, you learn how to change the shape of a text box and apply shape 
effects. 

 STEP BY STEP Change Text Box Shape and Apply Effects 

  USE  the  Profi t Analysis Boxes  presentation that is still open from the previous exercise. 

1.    On slide 1, select the  Fourth Coffee  text box. 

2.    On the Drawing Tools Format tab, in the Insert Shapes group, click the  Edit Shape  

button. A menu opens. 

3.    Hover the mouse pointer over  Change Shape . A fl y-out menu of shapes appears 

(see Figure 3-47). 

Choose a pattern

Choose a foreground color

Choose a background color

Figure 3-46

Apply a pattern fi ll to 
a text box
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4.  In the fi rst row, click the  Rounded Rectangle ; the new shape is applied to the text box. 

5.  Click  away from the shape  so that you can see it better. The corners of the text box are 

now rounded. 

6.  On slide 2, select the  Each division…  text box on the right .  

7.    On the Drawing Tools Format tab, click the  Shape Effects  button in the Shape Styles 

group. A menu of effects appears. 

8.    Hover the mouse pointer over  Bevel  to produce the Bevel options menu. 

9.  Click the  Circle bevel  effect (fi rst effect in the fi rst row of the Bevel section) 

(see Figure 3-48). The bevel effect is applied to the text box. 

Edit Shape button

Figure 3-47

Choose a different shape for 
the text box

Circle effect

Figure 3-48

Select a bevel effect
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Figure 3-50

Make the current text box’s 
formatting the default for new 

text boxes

10.    Click the  Shape Effects  button again, and point to Shadow to produce the Shadow 

options menu. 

11.    Click the  Offset Diagonal Bottom Right  shadow (the fi rst shadow in the Outer section). 

12.    Click  away from the text box  to see the changes better. It should resemble Figure 3-49. 

Figure 3-49

The text box with bevel and 
shadow effects applied

13.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Changing the Default Formatting for New Text Boxes 

 If you are going to create lots of text boxes in a presentation, there are ways you can save time in 
formatting them. One way is to redefi ne the default for new text boxes to match your desired 
settings as you will learn to do in this exercise. 

 STEP BY STEP Change the Default Formatting for New Text Boxes 

  USE  the  Profi t Analysis Boxes  presentation that is still open from the previous exercise. 

1.    On slide 2, select the  text box on the right .  

 Make sure you select its outer border rather than clicking inside it. (For this activity, it makes a 
difference.) The outer border should appear solid, not dashed, when selected. 

2.     Right-click  the  text box’s outer border . A menu appears (see Figure 3-50). 

Take Note

3.    Click  Set as Default Text Box .  

4.    On the Insert tab, click  Text Box , and drag to  draw another text box  on slide 2. Notice 

that it is formatted the same as the other one. 
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5.  Return the text box to the previous default formatting (no outline, no fi ll). To do so, 

follow these steps: 

  a.   Right-click  the  text box’s outer border , and click  Format   Picture . The Format Picture 

task pane opens.   

 Ordinarily when you right-click a text box, you would have the Format Shape command available 
instead of Format Picture, but Format Picture appears in this case because of the text box’s fi ll 
being an image (the texture). 

  b.  Click the  Fill & Line icon , expand the  Fill  category, and then choose  No fi ll . 

  c.  Expand the  Line  category, and then choose  No line . 

  d.  Close the task pane. 

6.  Set the text box’s current appearance to the new default by repeating steps 2-3. 

7.  Delete the new text box without typing anything in it. To delete a text box, click its 

 border  to select it, and then press  Delete  on the keyboard. 

8.     SAVE  the presentation. 

  PAUSE  .   LEAVE  the presentation open to use in the next exercise. 

 Working with Text in a Text Box 

 You can format the text within a text box in a number of ways: adjust alignment, change text orienta-
tion, set text margins, modify the text wrap settings, and even set the text in multiple columns. 

 Aligning Text in a Text Box .  You use the same alignment options in a text box that are available 
for a text placeholder: left, center, right, and justify. By default, PowerPoint aligns text in new text 
boxes to the left. If you align text to a different position, such as right, and then add a new 
 paragraph by pressing Enter from that text, the new paragraph keeps the right-aligned formatting. 
In the following exercise, you will align text to the center of the text box. 

 STEP BY STEP Align Text in a Text Box 

  USE  the  Profi t Analysis Boxes  presentation that is still open from the previous exercise. 

1.    On slide 1, click in the  Fourth Coffee  text box to move the insertion point into it. 

2.    Click the  Center  button. PowerPoint aligns the text so that it is centered between the 

left and right border of the text box. 

3.  Repeat this process for the  Ways to Maximize Our Profi ts  text box. 

4.  Click  outside the text box  to clear its border. Your slide should look like the one in 

Figure 3-51. 

Take Note

Figure 3-51

Center the text in the title and 
subtitle boxes on the fi rst slide

5.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 
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New orientation

Figure 3-52

Rotate the text 270 degrees

6.      Drag the bottom right corner selection handle downward on the text box, increasing the 

height and decreasing the width of the text box so the text appears in a single vertical 

column along the left side of the slide. Your slide should look like the one in Figure 3-53. 

 If you resize a text box that has centered text, the text re-centers automatically based on the fi nal 
size of the text box. 

 The Justify alignment option keeps long passages of text even on the left and right margins of a 
text box, similar to the way newspapers and many books align text. PowerPoint adds extra space 
between words if necessary to stretch a line to meet the right margin. This can result in a very 
“gappy” look that you can improve by adjusting font size and/or the width of the text box. The last 
line of each paragraph is not affected, since Justify does not work on single-line paragraphs. 

 Orienting Text in a Text Box 

 You can change the text direction in a text box so that text runs from bottom to top or stacks one 
letter atop the other. This can make text in the text box more visually interesting. You can also 
change orientation by rotating the text box itself. The following exercise shows how to rotate the 
text in a text box in two different ways. 

 STEP BY STEP Orient Text in a Text Box 

  USE  the  Profi t Analysis Boxes  presentation that is still open from the previous exercise. 

1.  Go to  slide 3 . 

2.  Select the  Indicators  text box. 

3.      On the Home tab, click the  Align Text   drop-down arrow  in the Paragraph group, and 

then click  Top .  

4.    On the Home tab, click the  Text Direction   drop-down arrow  in the Paragraph group. A 

menu of text direction choices displays. 

5.  Click  Rotate all text 270 8   (see Figure 3-52). PowerPoint changes the orientation of the 

text in the text box to run from the bottom of the text box to the top. 

 Take Note 
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Figure 3-53

The rotated and resized 
text box

7.    Switch to  slide 1 , and draw  another text box  on slide 1 in the top left corner. Type  Sales 

Department  in the text box.   

8.    Move the mouse to the  round rotation handle  at the top center of the text box. The 

mouse pointer changes to an open-ended circle with an arrow point. 

9.  Click and hold down the  mouse button . 

10.    Move the mouse to the  left  so that the outline of the text box starts to rotate around its 

center (see Figure 3-54). 

Figure 3-54

Manually rotating a text box

11.      Rotate the text box to about a  30-degree angle , and then release the mouse button. 

12.    Move the rotated text box so that it overlaps the corner of the title box. 

13.      Click outside the text box to clear its sizing handles. Your slide should look like the one 

in Figure 3-55. 

Figure 3-55

The completed slide with 
rotated objects



Lesson 3126

Text box margin settings

Figure 3-56

Set the margins in the Format 
Shape task pane

14.     SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Orienting text boxes can be a design enhancement for your slides. For example, you might create 
a text box that includes your company name in it. Instead of drawing the text box horizontally on 
the slide, draw it so it is taller than wide and then choose one of the Text Direction button options 
to change text orientation. You can also rotate a text box or any placeholder for a special effect. 

 Setting the Margins in a Text Box 

 PowerPoint enables you to set the margins in a text box. Margins control the distance between the 
text and the outer border of the text box. In this exercise you will change the right and left margins 
on a text box. 

 STEP BY STEP Set the Margins in a Text Box 

  USE  the  Profi t Analysis Boxes  presentation that is still open from the previous exercise. 

1.  Go to  slide 3 . 

2.  Select the  text box  on the right side of the slide, and drag it to the  left side of the slide , 

just to the right of the Indicators text box.  

3.    Right-click inside the bulleted list’s text box, and then click  Format Shape  on the 

shortcut menu. The Format Shape task pane opens. 

4.  Click the  Size & Properties icon  ,    and then click the  Text Box  heading to expand its 

options. Text box layout options appear (see Figure 3-56). 
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5.  Click the  Left   margin   spin button  (up arrow) to set the left margin at  0.5" . PowerPoint 

applies the margin changes immediately. 

6.  Click the  Right   margin   spin button  to set the right margin at  0.5" . Figure 3-56 shows the 

correct settings.  

7.    Click  Close    to close the task pane.  

8.      Widen the text box to  4.5"  so that each bullet point appears on a single line. Your slide 

should look like the one shown in Figure 3-57. 

Figure 3-57

Text box with new margins

9.     SAVE  the presentation. 

  PAUSE  .   LEAVE  the presentation open to use in the next exercise. 

 Resizing text box margins enables you to fi ne-tune text placement within a text box. For example, 
if you want text to appear 1 inch away from the left side of the text box, change the Left margin 
box to 1.0. You might want to do this if your slide design needs to have text align with other items 
placed on the slide. If you have chosen to format a text box or placeholder with a fi ll, increasing 
margins can also prevent the text from appearing to crowd the edges of the text box. 

 Changing the Text Wrap Setting for a Text Box 

 Depending on the type of text box and the way it was created, it may or may not be set to wrap 
the text automatically to the next line when the right margin is reached. In the next exercise you 
will learn how to view and change this setting. 

 STEP BY STEP Change the Text Wrap Setting for a Text Box 

  USE  the  Profi t Analysis Boxes  presentation that is still open from the previous exercise. 

1.      Go to  slide 2 . 

2.     Right-click  the  Each division… text box , and then click  Format   Picture . The Format 

Picture task pane appears. 
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Figure 3-58

The Wrap Text in Shape check 
box controls text wrap 

3.    Click  Text Options , and then click the  Textbox  icon.  

4.  Click to clear the  Wrap text in shape  check box (see Figure 3-58). 

5.      Click  Close  to close the task pane. The text now overruns the slide because it is on a 

single line. 

6.    Click in the text box, and click after the word  and    to place the insertion point there.  

7.    Press  Shift  1  Enter  to manually insert a line break. 

8. SAVE the Profi t Analysis Boxes presentation.

  PAUSE .  LEAVE  the presentation open to use in the next exercise. 

 Setting Up Columns in a Text Box 

 PowerPoint enables you to create columns in text boxes to present information you want to 
set up in lists across the slide but do not want to place in PowerPoint tables. As you enter text 
or other items into a column, PowerPoint fills up the first column and then wraps text to the 
next column. Viewers of your presentation may have an easier time reading and remember-
ing lists formatted into multiple columns. You can create columns in any text box, place-
holder, or shape. In the following exercise you will change a text box so that it uses two 
columns. 

How can you create multiple 
columns in a single shape?

3.1.2
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4.    Click  Two Columns. PowerPoint formats the list of items into two columns. The 

columns are truncated at this point because the text box is not wide enough. 

5.  Drag the  right border of the text box  to the right to widen it enough that two columns 

can appear side by side with neither one truncated. 

6.    On the Drawing Tools Format tab, click the  Shape Height   text box’s   down-pointing 

spin arrow , decreasing the shape height until each column contains seven lines of text 

(see Figure 3-60). 

Figure 3-59

Set the text box in two 
columns

STEP BY STEP Set Up Columns in a Text Box 

USE  the  Profi t Analysis Boxes presentation that is still open from the previous exercise. 

1.    On slide 2, drag the  Each division  … text box  to the bottom of the slide, under the other 

text box. 

2.  Click in the text box that contains the  list of divisions  beginning with Sales. 

3.  On the Home tab, click the  Columns  button. A menu appears (see Figure 3-59). 
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7.     SAVE    the  Profi t Analysis Boxes  presentation. 

  PAUSE. LEAVE  the presentation open to use in the next exercise. 

 If the column choices in the Columns drop-down menu do not meet your needs, click the More 
Columns option to display the Columns dialog box. Here you can set any number of columns and 
adjust the spacing between columns. 

 Aligning Text Boxes on a Slide 

 In addition to aligning the text within a text box, you can align the text box itself with other ob-
jects on the slide, including other text boxes. Doing so ensures that the items on a slide align 
precisely and neatly with one another when it is appropriate for them to do so. For example, you 
might have two text boxes side by side, and top-aligning them with one another ensures that the 
slide’s overall appearance is balanced. 

Another Way
If you need two 

lists on a slide but do not want 
to use columns, create two text 
boxes and position them side 
by side, or switch to a slide 
layout that contains two 
side-by-side placeholder boxes.

   Take Note 

Text box’s columns

are now balanced

Shape Height

text box

Figure 3-60

Decrease the shape height and 
increase its width to accom-
modate the multicolumn list



Working with Text 131

 STEP BY STEP Align Text Boxes 

  USE  the  Profi t Analysis Boxes  presentation that is still open from the previous exercise. 

1.    On slide 2, click the text box that contains the  two column list .  

2.  Hold down the  Shift key  and click the  text box at the bottom of the slide . It is also selected.  

3.    On the Drawing Tools Format tab, click the  Align   Button  in the Arrange group. A menu 

appears (see Figure 3-61). 

Figure 3-61

Choose how text boxes
should align

4.    Click  Align Center . The two text boxes are centered in relation to one another. 

5.  On the Drawing Tools Format tab, click the  Align  button again, and click  Align to Slide . 

Nothing changes in the text box placement yet. 

6.  On the Drawing Tools Format tab, click the  Align  button again, and click  Align Center . 

Both text boxes become center-aligned in relation to the slide itself. 

7.       SAVE    and close the  Profi t Analysis Boxes  presentation. 

  LEAVE  PowerPoint open to use in the next exercise. 

 The Left, Right, and Center commands on the Align menu refer to horizontal alignment, either 
in relation to the slide or to other selected content. The Top, Middle, and Bottom commands refer 
to vertical alignment.   

   Workplace Ready 

 PROOFING TOOLS 
  Even if you are a good typist, errors and inconsistencies can creep into your presentations. The 
Proofi ng tools in PowerPoint provide an extra measure of reassurance that an embarrassing typo 
will not be discovered in the middle of an important meeting.  

  Can you identify all the proofi ng errors on the following slide? There are 10 of them, and each of 
these would be found by the Spelling checker in PowerPoint. If you found all 10, congratulations! 
If you did not, type this text into PowerPoint exactly as shown here and let PowerPoint identify 
the errors.  

 Take note 
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Figure 3-62

Correct a single misspelled 
word from the shortcut menu

 USING PROOFING TOOLS 

 The Spelling and Thesaurus features in PowerPoint help you ensure your presentation’s text is 
professionally written and edited, free from spelling errors. 

   Checking Spelling 

 The Spelling feature in PowerPoint compares each word in the presentation to its built-in and 
custom dictionaries, and it fl ags any words that it does not fi nd plus any instances of repeated 
words, such as  the the . You can then evaluate the found words and decide how to proceed with 
each one. Misspelled words appear with a wavy red underline in the presentation, and you can deal 
with each one individually by right-clicking it. Alternately, you can open the Spelling dialog box 
and work through all the possible misspellings at once. In this exercise, you will practice using 
PowerPoint’s Spelling feature using both of those methods. 

 STEP BY STEP Check Spelling 

  GET READY . To check spelling, perform the following tasks: 

1.     OPEN  the  TV Options  presentation and save it as  TV Options Corrected . 

2.      On slide 1, notice that the word  Satelite  is misspelled, and that it has a wavy red 

underline. 

3.  Right-click the word  Satelite . A list of possible spelling corrections appears. 

4.  In the list, click  Satellite  (see Figure 3-62). The correction is made. 

The Bottom Line

How can you use Power-
Point to proofread a 

presentation?

5.3.2
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5.  On the Review tab, click  Spelling  in the Proofi ng group. The Spelling task pane opens, 

and the Spelling feature fi nds and fl ags the next misspelled word (see Figure 3-63). The 

suggestions list contains only one possible correction. 

Figure 3-63

Correct multiple spelling errors 
quickly with the Spelling task 

pane

6.      Click the  Change   button  to change to the correct spelling of  available.  The next 

problem identifi ed is a repeated word,  no .  

7.    Click the  Delete   button  to delete one of the words  no.  The next problem that appears is 

a proper name,  ValuCable , which is actually a correct spelling. 

8.  Click the  Ignore   button  to ignore the potential misspelling. You could have also clicked 

Add to add it to the dictionary; but because it is a made-up word for this exercise, 

Ignore is more appropriate. 

9.  Click  Change  to change to the correct spelling of  cable.  A message appears that the 

spelling check is complete. 

10.      Click  OK  to close the dialog box. 

11.       SAVE  the presentation. 

  PAUSE .  LEAVE  the presentation open for the next exercise. 

   Use caution with the Change All button because it may make changes you do not intend. For 
example, if you correct all instances at once where you have typed  pian  instead of  pain , it will also 
change all instances of  piano  to  paino . 

 Using the Thesaurus 

 A thesaurus is a reference book or utility that offers suggestions for words that are similar in 
meaning to the word you are looking up (synonyms) or that are opposite in meaning (ant-
onyms). PowerPoint includes a built-in thesaurus. In the following exercise you will use it to fi nd 
an alternate word.  
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 STEP BY STEP Change a Word with the Thesaurus 

  USE  the  TV Options Corrected  presentation that is still open from the previous exercise. 

1.    On slide 3, select the word  Costs . 

2.    On the Review tab, click  Thesaurus . The Thesaurus task pane opens displaying a list of 

terms related to the word you have selected.  

3.    In the Thesaurus task pane, hover the mouse pointer over the word Charges. Click 

the  down arrow  that appears to the right of Charges, then click  Inser  t  from the menu 

that appears (see Figure 3-64). The word  Costs  changes to  Charges  on the slide. 

Figure 3-64

Find word alternatives with 
Thesaurus

4.    In the Thesaurus task pane, click the word  Prices . The display changes to show 

synonyms of that word. 

5.    Click the  Back  arrow in the task pane to return to the list of synonyms for Costs. 

  SAVE  the presentation and  EXIT  PowerPoint. 
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 SKILL SUMMARY 

In This Lesson, You Learned 
How To: Exam Objective

Objective 
Number

Format Characters Apply formatting and styles to text. 3.1.4

Format Paragraphs and Lists Create bulleted and numbered lists. 3.1.5

Insert and Format WordArt Change text to WordArt. 3.1.1

Create and Format Text Boxes Modify shape backgrounds.

Create multiple columns in a single shape.

2.2.1

3.1.2

Use Proofi ng Tools Proof presentations. 5.3.2

 Knowledge Assessment 

 Fill in the Blank 

 Fill in each blank with the term or phrase that best completes the statement. 

1.      A(n)   is a container for text on a slide. 

2.    A(n)   is a set of letters, numbers, and symbols in a specifi c style or design. 

3.    The   feature, when needed, shrinks the size of the text in a text box in 

order to fi t it in the box. 

4.    A(n)   is a symbol that appears to the left of each paragraph in a list. 

5.    The   feature enables you to copy formatting from one block of text to 

another. 

6.    text is aligned to both the left and right margins of a text box. 

7.    A(n)   indent is a reverse indent for the fi rst line of a paragraph where the 

fi rst line is indented less than the other lines. 

8.    A(n)   object is text in the form of a graphic. 

9.    The   in PowerPoint can be used to look up synonyms. 

10.    To   a text box, drag one of its selection handles. 

 Multiple Choice 

 Circle the correct answer. 

1.     You can select a different font from the   tab on the Ribbon.  

a.   Home  

b.   Font   

c.       Layout   

d.       Review  

2.     You can select fonts and font sizes either from the Ribbon or the  .  

a.       Status bar  

b.       Scroll bar  

c.     Mini toolbar  

d.       File menu  

3.     Which of the following is not a paragraph alignment type?  

a.     All  

b.   Center  

c.   Justify  

d.     Right  
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4.     When selecting a color, such as from the Font Color button’s palette, the colors on the 

top row are:  

a.     standard colors  

b.     tints  

c.     shades  

d.     theme colors  

5.     Most of PowerPoint’s text placeholders automatically format text as a(n)   

list.  

a.     numbered  

b.     bulleted  

c.     sorted  

d.     itemized  

6.     Refl ection is one type of   you can apply to WordArt.  

a.     effect  

b.     font  

c.   alignment  

d.   spacing  

7.     A text box’s   determine(s) how close the text comes to the sides, top, and 

bottom border of the box.  

a.     orientation  

b.   margins  

c.     padding  

d.   alignment  

8.     To apply a WordArt style to existing text on a slide, you must fi rst:  

a.     format the text with a Quick Style  

b.     insert a text box  

c.     select the text  

d.     change the text’s alignment  

9.     What does it mean when a word has a wavy red underline?  

a.     The word is inconsistently formatted compared to the surrounding text.  

b.     There is a grammar error.  

c.   The word is not in the dictionary.  

d.     The capitalization does not match that of the surrounding text.  

10.     A thesaurus enables you to look up synonyms and  .  

a.     alternate spellings  

b.     antonyms  

c.     translations  

d.     pronunciations  

   Competency Assessment 

 Project 3-1: Blended Coffees  

 As director of marketing for Fourth Coffee, you have prepared a product brochure for new 
 company employees. This year’s brochure includes a page of new products that you need to 
 format. You will use Quick Styles to format the title and text placeholders. You will also correct 
a spelling error. 

  GET READY. LAUNCH  PowerPoint if it is not already running. 

1.       OPEN  the  Coffee Products  presentation and save it as  Coffee Products Brochure  .  

2.    Go to  slide 2  and click anywhere in the  slide title . 

3.  On the Home tab, click the  Quick Styles  button to display the Quick Styles gallery. 

4.    Click the  Moderate Effect – Orange, Accent 1  style. 

5.    Click in any of the  product items  on slide 2. 
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6.    Click the  Quick Styles  button. 

7.    Click the  Subtle Effect – Orange, Accent 1  style. 

8.    Right-click the  red-underlined word  and select  Caffeine  as the correct spelling. 

9.     SAVE  the presentation and  CLOSE  the fi le. 

  LEAVE  PowerPoint open for the next project. 

 Project 3-2: Typecasting with Typefaces  

 As an account representative for Graphic Design Institute, you are responsible for preparing a 
presentation for potential sponsors.  Another employee started a PowerPoint presentation contain-
ing a title slide, but when you open the fi le, you realize that the font choices are not appropriate. 
You need to modify both the font and size of the slide’s text, as well as change the horizontal 
alignment of the text. 

  GET READY. LAUNCH  PowerPoint if it is not already running. 

1.     OPEN  the  Graphic Designs  presentation. 

2.    On slide 1, select the text  Graphic Design Institute  .  

3.    Click the  Font   drop-down arrow . 

4.    Click  Bodoni   MT .  

5.  Click the  Font Size drop-down arrow . 

6.  Click  60 .  

7.    Click the  Center  button in the Paragraph group.  

8.    Click the  Format Painter  in the Clipboard group. 

9.    Drag across the subtitle text to change its font and size to the same as the title. 

10.    With the subtitle text still selected, Click the  Font Size drop-down arrow  and click  28 . 

11.  Click the  Center  button in the Paragraph group.  Notice that the subtitle is not centered 

exactly beneath the title; that is because the text boxes for the title and subtitle are 

different widths. 

12.  Click in the  title text box , and then note the  position of its right edge  on the slide. 

13.  Click in the  subtitle text box , and then drag its  right edge  to widen it so it is the same 

width as the title box. 

14.     SAVE  the presentation as  Graphic Designs Final    and  CLOSE  the fi le. 

  LEAVE  PowerPoint open for the next project. 

 Profi ciency Assessment 

 Project 3-3: Destinations  

 As the owner and operator of Margie’s Travel, you are involved with many aspects of sales, mar-
keting, customer service, and new products and services. Today you want to format the text in a 
slide presentation that includes new European destinations. 

  GET READY. LAUNCH  PowerPoint if it is not already running. 

1.     OPEN  the  New Destinations    presentation. 

2.      Go to  slide 2  and select the  slide’s title text . Click the  Bold  button on the Home tab to 

make the title boldface. 

3.    Select  all the text  in the bulleted list. Click the  Align Left  button to align the list along 

the left side of the text placeholder. 
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4.    With the list still selected, open the  Bullets and Numbering  dialog box. Change the 

bullets’ color to  Lime  , Accent 2 , and then resize the bullets so they are  125%  of the 

text’s size. Click OK. 

5.    Click the  Font Color drop-down arrow , and then change the list’s font color to  Lime 

Accent   2, Lighter 80% . 

6.    Click  Text Box  on the Insert tab, and then click in the center of the slide. 

7.    In the text box, type  Companion Flies Free until Jan  uary   1!  .  

8.    Select the text box you just created, and then on the Home tab, click the  Quick Styles  

button, and then apply the  Colored Outline –   Lime  , Accent   3  Quick Style to the text box. 

9.     SAVE  the presentation as  New Destinations Final    and  CLOSE  the fi le. 

  LEAVE  PowerPoint open for the next project. 

 Project 3-4: Business To Business Imports  

 You are the lone marketing research person in your company, World Wide Importers. You often 
fi nd exciting and potentially highly profi table new products that go overlooked by some of the 
senior staff. You need to draw attention to these products, and PowerPoint can help. Create a 
short presentation that uses WordArt to jazz up your presentation. This presentation will focus 
on precision equipment your company can start importing. 

  GET READY. LAUNCH  PowerPoint if it is not already running. 

1.     OPEN  the  World Wide Importers  presentation. 

2.    With slide 1 on the screen (but nothing selected on it), open the WordArt gallery and 

select  Fill –   White, Outline –   Accent 1,   Shadow  .  

3.    In the WordArt text box that appears, type  World Wide Importers . Reposition the text 

box so it is just  above the subtitle and centered  between the left and right edges of the 

slide. 

4.    On the Drawing Tools Format tab, in the WordArt Styles group, open the  Text Fill color 

palette    and click  Aqua, Accent 1, Darker 25% . 

5.    Open the Text Effects menu and select the  Cool Slant  bevel effect. (It is the rightmost 

style in the fi rst row of the Bevel section.) 

6.  Go to  slide 2  and select  all the text  in the bulleted list. 

7.    Change the font size to  24 , and then change the line spacing to  1.5 . 

8.    Click the  Numbering  button to convert the list into a numbered list. 

9.    Go to  slide 3 . Insert a  text box under the slide’s title . Type the following items into the 

text box, putting each item on its own line: 

    Digital controls  

  Heat sensors  

  Laser guides  

  Light sensors  

  Motion detectors  

  Pressure monitors  

  Regulators  

  Timing systems  

10.      Select  all the text  in the text box and change the font size to  24 . 

11.    On the Home tab, open the Quick Styles gallery and click  Colored Fill – Gray 50%, 

Accent 4 . 

12.     SAVE  the presentation as  World Wide Importers Final  ,  and then  CLOSE  the fi le. 

  LEAVE  PowerPoint open for the next project. 
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 Mastery Assessment 

 Project 3-5: Pop Quiz  

 As an instructor at the School of Fine Art, you decide to use a slide show to give beginning 
 students the fi rst pop quiz on art history. You need to fi nish the presentation by formatting the text 
and removing some unneeded text boxes. 

GET READY. LAUNCH  PowerPoint if it is not already running. 

1.     OPEN  the  Art History  presentation. 

2.    On slides 2, 3, and 4, do each of the following: 

   a.   Format the slide’s title with the  Intense Effect – Dark Blue, Dark 1    Quick Style. 

   b.   Convert the bulleted list of answers into a  numbered list . 

   c.   Delete the text box (containing the correct answer) at the bottom of each 

slide. 

3.     SAVE  the presentation as  Art History Final  ,  and then  CLOSE  the fi le. 

  LEAVE  PowerPoint open for the next project. 

 Project 3-6: Graphic Design Drafts  

 As the account representative that prepared the Graphic Design Institute slide, you want to make 
sure that nobody uses this presentation before it is approved. To protect against someone 
 inadvertently printing the slide, you need to add a text box across the entire slide that labels the 
slide as a “Draft.” 

GET READY. LAUNCH PowerPoint if it is not already running. 

1.     OPEN  the  Graphic Designs Final  presentation you completed in Project 3-2. 

2.     SAVE  the presentation as  Graphic Designs Draft . 

3.    Add a  text box at the top of slide 1 , and type  DRAFT  into the text box. 

4.    Rotate the text box at a  45-degree angle , and then place it in the center of the slide, on 

top of the existing text. 

5.  Enlarge the text to  88  points. Resize the text box if needed by  dragging its sizing 

handles  so the text fi ts properly inside the box. 

6.    Using Text Effects on the Drawing Tools Format tab, apply the  Orange  , 18 point glow, 

Accent Color   3    glow effect to the text. 

7.     SAVE  and  CLOSE  the presentation. 

  EXIT  PowerPoint.  


